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ZIEof 1A% | [USB TO HOST] &K} 2 At23L Lt 0]
72 2|0 10749 o] @ MU(ETHO| AL )2 A
g+ AsUC S AE 2 EHE2 TS 2ol HAIE
LiCt. [EDIT] = [Part Settings] - [General] 3tH9| “Part
Output”

MODXe| |2 415 & [USB TO HOST] ©Xtet A/D INPUT
[LIMONOY/[R] Holl A U2% 4 &L

|} 4719] QCIQ &H'H(2742] AH|Q &H'H)0| [USB TO
HOST] AI2 2T 4 U&LICH 24 8101w TR A
B B0 A £ M-S HFEUCL 0] MEE OUTPUT
[LIMONOYIR] (27| &ii'd)0 2 E BT 3t 2/ch 27}
of 20| #'A(17Hol AH2| 2 *Hd)o| AD INPUT [L/
MONO]/[R] Ho 2 OIEdEI A OI/\L‘IE_I- ol Al : ODXO'
AD 9 THER2 MAEUCH XHA 3 82 BT MEA
PDF 2AMZ ZHESHYUAIL.

MIDI %j{'d % MIDI ZE
MIDI cil | E4= 167Ho] &' 3 BHLIoll XITEI0f, &= ACIALO|RY
= 16742 MIDI i & Sl HE 9| 1674 WEE S A0l RHAY
o 4 lgUch SRR 242 167) A28 R Aste Heol
MIDI “ZE S-S AFR510{ 0] 16 3tA|2 225t A5
QL& LICE BHLIQ| MIDI {0122 SAloll ZIch 167H =20l A
HI0|EZ #2|3 4 T, MIDI ZES 0|25/ USB HZ 2
B4 O 2 HOIELS XI2/E 4 QLI 2240 MDI =S
£ 16H'd 2 H2IE 4 T USB HZL | BEES /8
S22 HAEOIM 1260 2(BEE x 16K1)S 0|8 4
gU
USB 70|22 o83 2 47|18
EEL 2 2ol olgU

HFEO AZE Wi MIDI

2 a7|o] EXUHOIE EE2 0| ZEDRF QIASIT AHE
£ AsuUct o/ B MIDI #X| E&= AFE0 A MODXE E
MU O|E{ 2 RHY & M= HAAE MIDIEHR| L= AFEEUA
MIDI ZEE 12 X sHoF §HCt.

e

0| ZE = MIDI Thru Port2 AFREL|C} [USB TO HOST] &K}
ZE 30| 248 MIDI H|0|E{ = MIDI [OUT] X}
Q| MIDI x| 2 RHM S E/Lc}.

MIDI [IN] ZX}E E35f ZE 30| A] 441E! MIDI | 0|E{= [USB
TOHOST] X2 Esl 2|8 &X|(AEE S)2 M SEUCH

USB ¢ZA S AtEst fjof|= MIDI M4 Hé 2 MIDI =41 zHE
ot obL|at MIDI M4 TEQFMIDI £41 TEZ AUX|A|7{0}
SHLICH 90| kol mhat & of7|of| HZE Q& &E|2| MIDI

ZEE 2¥stiof gt

m MODX A8 42




HREE A8l & 44

MODX0|| 1A=l Zd ZE{0f| A DAW A I E 2|0} &7 MODX
E AME5tH OIS 22 7| st o E| A0 HE o] 8 4+~ US
Lok

o DAW A = E9[0{0fl MODX 9120| MIDI =2 U QC|Q =2

e MODX £ H|LH2|0|E{ & AI25t0] DAW AZEQ0{0f|M =
7Y
0] E20[A = MODXE 2% & HAFE{0| A DAW £ ZEQ
019 & AFREH= HItH S AN E L CH55H| 0| X|).

MIDI Cf|o|E{ 2 HFE{ 0] MODX HF =F

(5=H of2H x| x4 9IS

o| &S At25tH MODX ¢4=E2 DAWO|| MIDI H|o|E{ 2 7+
T5l7 =& & UYALICH OFZH A @ KL =S E|X| o4

Lich,

MODX & X

1 [UTILITY] HE S &3] SHalE SHHS g2

Lict.
2 3t IZ0] [Settings] & > [Quick Setup] & &

E{X|5t0] WHE 2 stHE S SUCH

3 “Quick Setup”2| “1 (MIDI Rec on DAW)”2 AEH
gt

Utility

Sys/MFX &

Tempo  Audio
Settings  1/0

Effect MIDI
Switch

Arpeggiator —— Ton

MIDI Out

Store Current

guo.
DAW AZEgo] 43

1 DAW A Z E9|o{0fjA] MIDI Thrug “on”22 HH
gt
MIDI Thru& "on"© 2 A 5tH 748hS A F3510] AOH/gE,_I
MIDI H0|E{7} AEE{ 2 M&E|QCH7 CHA| MODXZ Eof
SLct of2f ol ofj ot ZHo| MODXo| A F&El 5 MIDI xnu
12 E5) ZEEZ S5 MIDIHIO|EL= =8 Eo| MY
off w2t MIDI &' 32 S5l #EE{0| Al MODXZ &| S0}
ZLICH 1 Z 2} MODXO| £ H|L{3|0|Ef = 714t (12 S5
MM =l MIDI O|0|E{ & x{'d 32| MIDI G| 0| E{ 2 RHAYSHL|C}.

[USB TO HOST] &4x} ,l_[‘
]
£ Hziole =5 I ZEHMIDI #4'2
('VllDl ' 32 Sa 12 ¢ =3)
Gllo[Ef @l4| +—0
Local Control = off
MODX IN | JouT
CHA1 CH3
v
MIDI 01
MIDI 02
[m]| s|mDi 02
H=E MIDI Thru = on
(Cubase )
2 DAW AZEg[0{0] MODX ¥F & & SELCt.

MIDI G|0|E{ 2 ZFE{ofl MODX ¥ F 55
(52E o2l x| x4 =

0| 2 AF25HH MODXO| Of2H|X|Q KHAH-S DAWO|
MIDI ClO|E 2 =28 4 9aLct

MODX A&

1 [UTILITY] HEE
Lct.

2 3}H Z0| [Settings] & > [Quick Setup] & &
E{X|5to] B E 4 5lHE 22| SLC

3 “Quick Setup”2| “2 (Arp Rec on DAW)” & MEH
gt

=& fEaE StHE ERS

Utility

Audio Signal Flow

Sys/MFX @

MIDI Signal Flow

Keyboard —— Arpeggiator

MIDIIn

st
DAW AZEQo] A%

‘MIDI H|0|E{ 2 ZHFE{0| MODX HF 55(52E Of2H X2
Y E)el seet 2E BAHIE TGEHAIR

MODX Ab24H A



HEE HFEH AE

MODXE £ H|L2]|o|E| 2 AFH83to] EHFE
oM & xHd

o2l X|&l2 & 27| 2 MIDI £ MY 0|E{ 2 A5t ity
2 2o ELC} o] AL M| MIDI A| A H|O|E{ 7} ZEE{Q
DAW A ZEQo{of A M&E B2 MODX7} MAtsHe 48X

S82 885 SAl0 AT EY0] AC|ALO|X{ S AFRSIX]

I_ O o
oot ZFEIO M2l MG BUSHE 27+ 0IFo| Y&UCE

E8|0| 5}B10] [Mixing] & Eix|5t0f
g gaiguct.

3 mWeo oat1~16 THEO CHal 42 H-Ect.
DAW AZEQJof HH

1 MODXE xjAi517| /3 E&io] MIDI &3 ZE
£ MODXe| ZE 12 4AstLc}.

2 ZEZE{0|A DAW A X EZ0{Q| Zt E2Hoj| MIDI
mma=ﬂaﬂuu
MIDI E240f| s st THEQ| £ A|L{2|0|E MY
MODXQ| Al st 0i| A AL A|ElLICH.
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ClolE /&2 7|

=22/ El 82 MODXe} [USB TO DEVICE] &Atol| 4 AE USB Z2iA| E2t0|E FX| 7F A AAR 47

% 2f0|H HE)E BEE 4 Ut AT MBFUCH

T AT T E=E

3 CllolE{(of]: T =

o HHAME 2 7|2 ArEXF M2 o U= ZE HIOIHE "User” Lt 2 MYt 22{2= YHo| s @Fect

USB Z2jA| E2}o|HO|| M x{Et

1 USB E2jA| E2l0|EE & o
DEVICE] x}oj| | ZA3tLc}.

71| [USB TO

2 [UTILITY] HES &2 REZE HE 22
S 3}H 2Z0j| A [Contents] B > [Store/Save]

'%.!I% E{X| gt
”2 “User File”2 A

3 “Content Type = gtct.

4 USB BajA| Cato|=o| Wste ClYEa|E Mey
stLc}.

O u2l 2o

@O USB ZaljA| E2to|H9| XA Chat =
© AT XE A

0 7|1z 1y

9 [Save As New File]2| “+”§ E{X|§tL{LC}.

=
JIELYUS E{X|&tL]C}.

HQ

of A I o]

oju
mjo
el
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6 Xt eI= stwio] LIENELICE M E Y 01 0|88
QU= FLICE.
0|5 Yol that RtMIEt LHE2 “7|2 s ¥ &t
EA 579 0|5 XE(EX )" E HES

4| o[ x]).

7|E otd S Fo{Ma{ 5tHEol “YES'E MEigHLCt O3 £ol
OIAIR| 7} LEEFE L T

USB S2lA| E2to|HO|M 478 E2]
7|

Fojure

22|27 ZE HAISHE &2 247[2] 7|E H|o|E|7} FojA 7| EILCt

o2t 2% CIo|E £ g4 [USB TO DEVICE] Eixfoll HZ & USB
= Al E2tolEofl x|FsHof gL Ct.

1 USB E&ljA| Cato|HE &
DEVICE] Tx}of| oqu;uq

2t7|2] [USB TO

2 [UTILITY] HES &3 QHIYE| StHE E32
S 3t 2AZF 0 A [Contents] B > [Load] B2
E{X| gt

3 “Content Type”& “User File”2 A& $tL|LC}.

4 UsB EaliA| Eajo|Ho| Ast= BCiE ML

5 0lZajo| IYU(EFERL: XsU)S Hestol Eai27|
stelg MHLICH

© LA USBEZaAl Eatole
® usB
O 7|z ty

Al EEfO[HO| A A EH



[USB TO DEVICE] & X} Al A] 9]
Are

2 2700l L& [USB TO DEVICE] ©XE7t &L T USB
RIS R0l Y 1 245 M USB RIS #3sHoF it
o2} FRE FoIARE T2AAIL.

;

USB HX| # =0l CHEE REA|EH LHE2 USB X9 AHEHBME
S AR

o
2l

USBSE, ZHFH 7|EE E&= 01RAQ 22 OHE USB HX|&
AR 4+ g
2oyl U A48 USB MRS XIUSHR| o4

Ho|X| & EHASIHAIR.

https://download.yamaha.com/

Support Y/ Ao| E0]| T 435}0{ 'Documents and Data'E 22t
|

4
Ch ST 2 0|22 YHUSHAIL.

USB &X| 1.1~3.02 & &7|0f| AFEF 4+ 2oLt USB X0
MEStHL USB EX[0M 22| +& Ol A25|&= AlZH2 H|0]
E{Q| YA = ob7[o| HEHo mat tHE 4+ U&U Tt
FEolAtgt

USB TO DEVICE ©x}o| M2 £|cl| 5V/500mAQ/LC}. o] & = 1I5t=
FZ9| USB ¥X|= HFSIX| OHAI2. 27| XtH|7} &4 8 +~ US
Lct.

USB &x| &

[USB TO DEVICE] &Xtof| USB HX|E 4 & W= X9
HUE 7 S BHEHR|, YU WHO 2 HHE| UK 2OI5HY
AR.

Fo/utg

* MY/sS, Il e HUKE, SAL AH|, Z9%) E= USB FX|
WA F0ll= USB X & P F= 223X NS 5HAIL.
33X g B2, A71e] FE0| “HE7 L USB EX| U HIolE
7t &4 = AsH.

¢ USB ¥zx|® d@E * E2(EE 2 Hh)stE Z0E 2 =Y
Atojoll ® =7t 74 E R4 AL,

clolE XE/@z 27|

USB Z2jA| E2}0|H A}
et7|2 USB Z2jA| E2to|EHo| HAASHH AZL| QU

KH4Al0| BHE HIO|EHE MEE 4 QS ot ot} AZE &R
olM HlolE{ S g 45 A&

A3 4 U Z|Cj USB E2fA| Ea2toHO| 4
17H2] USB E2A| E2to| =7+ [USB TO DEVICE] hXtof| 12 &
& &t

USB ZajjA| Ea}o|H ZoH
USB E2fiA| Eeto|EE 2 7|2
OHE EX|O|A ZoSHUSB E2{A| E210|E & K| 2 &H-551HK]
g 4 Uit

Fo/A 8t

=9 =42 513 o] Mol T Clo|E{ & 2 F ol M| Fct Y
USB E2liA| E2to|Hof| Z2F H|o|Ej7t RIEX] HIEA| & QIS4 A 2.
=

USB Z2iA| E2}0|

PDF 2ME EA5HUAIR.

HIO|E B3 (&7] ¥X|)

2x0|2 F25 Hl0|E7F AHEIE XS WXt H 2
SefA| E2t0|Holl HBEIE 47| WX 7|52 MBFHUAIL.
USB 2 Al E240| =0f| T 0| & XZ5Hs B2 ¥

YK 7|5E sliAsHUAIR.

rir

ot7| 17|

o712 B U MA/SS T T (K, A ALK L
Zo 5he] S)2 9lsh 24717t USB B2l Al SatolHof Ay A
BH1 QUXIE K| BLEA| BQISHIAIS. J-X| e1B USB
ZefAl 20| =9t Clo|E{7t 24E 4 UFUCH
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o7]0] U FL 7|5 HUS WY U0 HET|S 0|85 ZHHE W £ UsUL
[SHIFTTHES &2 JEiolM ZAIE HEOIHAM €8)s =23 HYL}
falk s
[SHIFT] + KNOB POSITION [1] LH X|™EE K™ 1-88 Z}F 10| XM &HstLCt.
[SHIFT] + KNOB POSITION [2] LEO X™HE X|™ 1-88 20| MZHghL .
[SHIFT] + OCTAVE [-] 27 ZFS 1M ZHA AL}
[SHIFT] + OCTAVE [+] X827 7S 18 E7HAIZLY L
[SHIFT] + OCTAVE [-] + OCTAVE [+] 2272 72 002 RMHSLLCE
[SHIFT] + [DEC/NO] MEHE oh2t0[E gt3 104 HAAZ U
2t0|E2 M E SOl M o] 2t¥2 0| H|O|X|E 2 ZLCt.
[SHIFT] + [INC/YES] MEE TRtOlE| 24 104 S7HAIYYCEH
2t0|E2 M E &M o] 2t¥2 CtZ HIO|X| & 23St
[SHIFT] + [ENTER] "z 4y stHs 22U
[SHIFT] + [PERFORMANCE (HOME)] He stHe 2Lt
[SHIFT] + [LIVE SET] 2t0|E ME S8 stHE 283Ut
[SHIFT] + [UTILITY] HE MY stHE 28It
[SHIFT] + [CATEGORY] T MEAEl ThEOf Ch3f THE FhE| D2 HA BHEIS B gUT

[SHIFT] + &2to| &% [1-4] [5-8]

£2to|0] 7|5 [PART)/[ELEMENT/OPERATOR] B{E0| “PART’2 M &[0 !
OE 9 &= GtE 1338 Medgtyct.

[SHIFT] + [EDIT]

SAHw g tistE Fuch

[SHIFT] + SCENE [1]-[8]

SCENE [1] - [8] H{E0f| SCENE 1 - 82 XZ&gLICt.

[UTILITY] + [PART SELECT MUTE/SOLO]

0
[

Bl iid 28 4% st
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LCD HEA|

** will be deleted.

3

O| IAIX| = Hdl5t = X8 AP 2

gt

ols x| E HIO|E{ 7t AMR|E| = A9 Lt

** will be overwritten.

o MIAIX|E MF5t2iE TIU D 0| F0| SUB THY/BCI7E o0 EXE 0f Lheke
Ytk

Activate the source controller to assign.

Sstale HEE ato|HE XI-Y &+ A&

Advanced settings will be initialized.

[Advanced] R0l M HEE 2= 20| £7|sHE U

All data and libraries will be initialized. Unsaved
user data will be lost.

== diolH ¥ 2to|EE{2|7t Z7|stEUL. MEEIX| 2 Hlo|E = &dEUH

All data is initialized upon power-on.

Melo| 7AE wf 2= H|O|E{ 7 =7|sbELCt.

All settings will be initialized. User data is kept.

2= 2¥0| z7|stEY. AFEXf OB 7t R X[EH U

All sound will be stopped during optimization.

[AXE U5 227t S2E|7] Mol HEFE U 2[ M3t & 2 E 80| FX

All user data will be initialized. Unsaved user data
will be lost.

FEXF dlolB{ 7t =7|stELCH MEEX| &22 HolHE= &

nZz
ot
r
il

Are you sure?

- o = =2 T -
Arpeggio full. o ol ¢ Z otZHX| 2 THE AQ|X|7} ¢S W LEFFLICH
Assignable Knob Full. X8 7ts LB EF ALE 0|2 o1 LH 2F2 O 7t & gl W HEY

Audio Rec stopped due to lack of memory space.

USB SajA| Sa}0| =7} 7HS X O 0]42] 2TJQ =& Hlo|E1S MEY 4 giaUCh
M2 USB B Al 20|25 ALE3I7{LE USB Z2fiAl E2to| oA BE a3
HIoIE{ S XIS oif B7HS StEsHAlL.

Auto power off disabled.

Ol HIAIX|= QE WY R 7|50| FX|&|7| ol LJEHLLIC.

Bulk data protected.

Can't process.

1S 3t
MODX7} Q= Xt xa|at & ¢

Completed.

Connecting to USB device...

ANEE 2227 &, 2 E& 7|B O E 5Yo| e UEY
= o

& XN [USB TO DEVICE] ©+X}of| 9 Z 5l USB ZajjA| Eato| = E QlAlstT Y&LIch

Control Assign Full.

Copy protected.

2= HEE XFo| A8 FYY
A

SALXE OXE 20 A

HEUHAL M5t A= EHH
2oz 4

Current user data will be overwritten by **. o] A K| = oY & XMZEH5t0] sHE of Z AM2X} O|o|E{7t o|O] ZRHE ulf LIE}
ot

Data memory full Lj & o @27} 7+S &t 2to| 2 22| ofl 5 E HIO|E{ 7t K| X| & LCt

Device number is off. R HE7H MM I HIO[EE $441E 4 gtgU

Device number mismatch. EHX| HS 7t UX|5HX| ot 3 OO|EHE £ 4418 4+ g&UICTH

File is not found. =HE W XZE oo AMEX| pItEUD

File or folder already exists. MEStE = It o| 20| SYUSH IHY/Z{ 7t oo EXiELCH

File or folder path s too long. 22 BAISHE 2R 471 LR 20| 0|85t2ik she T T SCiof UM A
4 gauc

Folder is not empty.

lllegal bulk data.

fo
o
=2 J
>
Ral
4>
>
o
to
Ju
N
e
0%
3%
i}
i
o

lllegal file name.

Ral
oA
ro
E

o

2
=]
i1}
o
"

Q
i}
r
il
o
rlru
=]
Oju

[0
i)
1
f‘,l_'
igal
Ral
to

M . =
llegal file. of AlC|Abo| Kofl ofa XIHE TtUS ALBE 4 glriLt 2212 4 glaUCt
Keybank full. 2297 2 UME uf Ay W0l 2ty MA 47t E 1| UsUC
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Bt BA| HIAX]

LCD BA| 43

Library full. TH Xtelg M o ato|Ha{a|o| F|oh M| 47t ZIpE|Y AU

MIDI buffer full St ol 42 B2 oO[E{ 7 4 AE|{7| T 20|l MIDI G0|E{ S &2l 4 glaLct

MIDI checksum error. H3 HOo|E £41 & QE7F B Msi&LICH

Modified: Common AsgnKnob? TE B QI HES K| 517H0| AT L-Ho} BT XY JHs oo HHE
FINEEHBE M SE/QUR MU HEE XY BHO|AISHRZE FILEE
WA e L

No data. Of AR &= MEHEI E2f o= e Q|of| ZEHE COJE{7t @S mf LhEHTLICh X
E EE QIS HUEHAIR

No read/write authority to the file. oY o1 M= HFto| g2 LIErHLICH

Now initializing all data... AMCIAMO| X7t E0 Al =22 08E ™8 E5tD Q28 LHEpHUCH

Now initializing... X8 HIo|E{7} =73t SIS LIEHHLCH

Now loading... nYg 229 U8 et

Now receiving MIDI bulk data... AC]AFO| X7} MIDI 43 |O|E{ & 4415110 Y28 LIEPHLICH

Now saving... THUS MESH D USS LIEHHLICH

Now transmitting MIDI bulk data... AMCJAFO| X7} MIDI 3 H|O|E{ & &415t1 Y22 LIEFHLCH

Part Full.

DE ET}AG FYULH

Please connect USB device.

Qr|Q =32 9|5 [USB TO DEVICE] T+Xtol| USB &%|S 1R gLCt.

I

Please keep power on.

2 Al ROMo|| Hlo|E{ & A1 U&SLICt HIo|H E S Al ROMof| 241 QL= St
2o MHE IX| Oy AI . O HIAIX|7} AR I MH S N 2= AFEX}H|O|E{7}
AHIE[D A|ARYO] BEHE 2~ UAEHULCHEZHAI ROMOIO|E{2] &40 2 Qlaf). EFt
Ch2oll TS Z o MODX7H MITH2 AIXEIX| §E 2 +& AEH

Please reboot to enable the new Audio I/O Mode. | 0| AIC|AIO| X E RHEEISI0] QC|Q C|O|E{0]| CHEH U/E2 M H5IE &35}
gt

Please reboot to maintain internal memory. O| ACJALO|ME RHEESH] LHE M| 22| & B35 TAHAIQ

Please stop audio playrec. AEHE sol2 orle 52 Ei& x4 Fofl duy 4+ glaun

Please stop sequencer. A A=S e & MY Bols A48T 4 gauc

Please wait... of AlCIAbOI X7} R Atolg a5ty g g LIEbLICH

Recall latest edits. HEIHAS WY 5 HHUE LSS MYSHA| AN LHE HEUAS M5
ge 2= W WEo| ArEUL o] B 22|27(E AtEsto] 2|2 HY LHES
a2 RXIsHEAM HEUAS 278 4+ s

Redo last recording. FlAgHES YT AAX| Helgty Lt

Sample is protected. MEOOIHE §0{& £+ gl&LULct

Sample is too long. ME I717tHR AHM 23127 Y S 2T + gy

Sample memory full MEZ o227} 7tS &F 271 £2(Q7] HYS MaE 4 elsUct

Scene stored.

[SCENE] HE

Song data overload.

& 2717t M 4str0 42 U

Song full.

oE RYs e o $2f |0 X #7F ZotE

Touch the white square.

Turn on Memory Switch to memorize ** into this
scene.

o]
O HIAIX|E HX| HE W & BAIE &M A2 Ex[sloF & wf LhEHE U T}
i

[Memory] (H| 22| A{X])7} 3T 7|50 27 AE=E [SCENE] B E0f

—
=

Undo last recording.

s 715 PEJtAHEe R MEEUL
sto

718 5| 29| 5852 FAT AQUX| Eelgynt.

Unsupported USB device.

USB connection terminated.

HIF A 7] M5 w20l USB E2ilAl E2to|Eoto| AAA0| Fo{R&LCh
[USB TO DEVICE] ZXtofl A USB E2iA| E2to|EHE 2|3t 2 '8 HE & o7

AL F2AAQ.
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ElH BA| HA|X|

LCD HEA|

29

USB device is full.

oA

USB SallA| Sato|=7} 745 XbM HIOEf S Of 0|4 MEHe 4 &LICH A US
ZafjA| Cato|HE AFRSIALE K BX|0 A 2T RE Olo|E{E X A5t
SHEIHAIQ.

USB device is write-protected.

USB device read/write error.

O| HlA|X|= 2S5 USB E2lA| E2t0|H0j| 7|E2 5t
L

USB B2§Al S2{0|HE Ql7iLt £ U RF7} HMHE

USB device will be formatted.

Waveform full.

O HIA|X|= USB &X|7f ZEHE|7] Tof| LJEFH LT},

o
23 RS MYE of Yol Elo) MA 471 ZREIUSU
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AF2ETH EEHER| EEUT? ZERE AR EI EHEHUI? 0|t 2 EHI7F 2YSHHE KF0| o] o] AUntd THSHT| Hol| o
EE22 st AL. HI0|HE USB 22 A| E2t0| 2 (60m|0|X|)Z ¥ A3t = H|o|E] =7|sH(19H|0|X|)E L& stH HE L9
ZHEMNZBE + AFULH D= EHM7t HEEIX| Z2H Yamaha UM 0| E2I5H A L.

EiX| oli'do| SHI2H| #HS5tx| h&UCt.

B{X| o' 20l M Efx|Tt X| o of2H StHO| CH4 b=t SHIEA HFHH ASUMN?
E.IXI u_HL:|° _)K-Iol-AlAlg

[UTILITY] + [PART SELECT MUTE/SOLO] > [ENTER]

[UTILITY] - [Settings] > [System] - [Calibrate Touch Panel]

—|—

—S—E I 385X f&U.

= &20| 71 (0 £ 2| ATt ofH) MAESHEE HHE A&UMN?
ODX7} 2C|2 0|28 S5 & & Fx|(0: YW=, AL, S| =&)0| SHIEA FAZ| USUI?

MODXO{IE ADHIL HEEO] UX| foB2 MAES BHEHE S fciMe 28 QUL AAR E= AHZ R HEE MET;
ZosgtLcH(18m| o] X]).

I-D

i

nE!

MOALOI X 0| 74X U1 AIT]AtO|X{off AZE 28 FX|o| M o] 74X UEUI?
ACIAtO| MOl Z 2% W HBE ol TR|O S HHS Esto] HE HUR B MYHALIN?
X AEE2(7t [FOOT CONTROLLER] Mof| 1ZE A X HEEZE ofeliz S EUT
24 UEE m2t0|H7 HELZ EH-Eof A&5UM?

EZ UEE T0|EIHEC R HEE ER 12 AFs = 0| WHEX| d&UC
[UTILITY] > [Settings] > [MIDI 1/0] - “Local Control”

HlOf Qi THE T} MEHE| Q&L

I3 22 IE 22 XIEsH7L T2 MEE MESHA|2

2 IEQ| 8 A AQIRIZEAK U&UNG?

SA7 AQIXIZE AT AL 7t AZS T S0l MHEIX| QL

[PERFORMANCE (HOME)] > i E “Mute”

[PART SELECT MUTE/SOLO] > “Mute” > T}E AMEH

2t IHE Q| M HEZ0| K YU

[PERFORMANCE (HOME)] > I}E “Kbd Ctrl”

2t TtE O] “Arp Play Only” met0|E{7t 74X USL7H?

ol mtztO|E 7t 74N & W= g THETL OFEMIIIQ_ HES SsHAM T 427t GLCt
[PERFORMANCE (HOME)] > mtE MEd > [EDIT] > [Part Settings] > [General] > ‘Arp Play Only”
[PERFORMANCE (HOME)] > mtE MEHd > [EDIT] - [Arpeggio] > [Common] > “Arp Play Only”

QI ZAEEZ 0|8 A MIDI 20|l MIDI 23 HYo| T ZX| &L nt?

o|l"HlE U TE Ao X{x-l%l—|_|7}|-’?

LEIS AI8 50 42 AIY FI4E HZsH 24AIQ YR AT HHo=2 BE 30| 23T & s

[PERFORMANCE (HOME)] - [EDIT] > [Effect]

[PERFORMANCE (HOME)] > TE ME{ > [EDIT] > [Effect]

Ut TEAWM2) Y £ IHEQ| B

[PERFORMANCE (HOME)] > THE ME{ > [EDIT]> 24/7| M > [Filter]

Uit LE(FM-X)2| E<

[PERFORMANCE (HOME)] > THE MEi > [EDIT] > QHa||0|E{ MEH > [Pitch/Filter]

“Vocoder’7} THE Q| OIME O|HIE E}QIO 2 MEHZ| Q&L 7}?
Ik A/D INPUT [L/MONOY/[R] ® 2t 2t E Di2t0|HE 751 X3t 7t0 2 MA3H 5 MODXO| 91 ZE Ofo| 30| SAHS olatst
WA AU AFSHYAIR. 5 T | A/D INPUT [GAIN] = E 7} £| A QX2 L0 UX| =X EQUSHIAIR

[EDIT] > GE MEd > 2 A/7|/Q 13| 0|E{ [Common] > [Effect] > [Routing]
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oLt 53 B0l HR IX| E&EUI?
[UTILITY] - [Settings] - [Sound] > & H|L{2{|0]E{ “Volume”
[EDIT] - [General] > “Volume”
[EDIT] > ntE MEd > 2 A/7]|/212|0|E] [Common] > [Part Settings] > [General] > “Volume”
[EDIT] > ntE MEd 5> 2 A/7|/Q 1| 0|E{ [Common] > [Part Settings] > [General] = “Dry Level”
* UgHOHE(AWMR) % EF THEO| B

[EDIT] > mE MEH > @ A/7| MEH4 > [Amplitude] - [Level/Pan] > “Level”

* UBHTHE(FM-X)2| 32

[EDIT] > T}E ME4 > QHz|0|E{ MEH > [Level] > “Level”

E R N7 = Mat 22 utato|E 4ol HE

o 3%

& gL
o Uuh IE(AWMR) W £ IHE
[EDIT] > mtE MEH > 2 A/7|/m2||0|Ef [Common] - [Part Settings] > [General]

[EDIT] > THE Mef > @ A/7| ME{ > [Osc/Tune]

o Uik TEFMX)Q] B2

[EDIT] > ntE MEd 5> 2 A/7|/Q 1| 0|Ef [Common] > [Part Settings] > [General]

m GfEO| 2t 9 A/Qu{2f|o[E{OtL; §A4H AX|I7 AN USLIN?

[EDIT] > TtE MEH > 2t 9 A/Q 2| 0|E{2] 847 AQX|

m Yt T E(FM-X)2| F2 7H2|of 2 o] 0" 2 EF |0 USYIH?

[EDIT] > THE AMEH > Q|0|E| MEH > [Level] > “Level’

® 2t ItEO| £ Wato|E{ 7t HA UL LT
[EDIT] > ntE MEd > 2 A/7|/2 13| 0|E] [Common] > [Part Settings] > [General] > “Part Output”

A/D INPUT H0j| A O}
m O0p0| 3 AQX|7t AKX Q&L N7
Qlstd Al Tho|Lte Oro| 2 & ArZsHof gLt

m O0f0|3 E= 20 FHI|Q 2 27| Ato[o]| Ao E0| M2 HAENU
m A/D INPUT [GAIN] = E7} 2| A Q|X| 2 S0t7F AEHQIL|7t?

= A/D INPUT [ON/OFF] B{E 0| 74X U&UL7t?

m A/D INPUT [L/MONOJ/[R]2| 917 AEf7} “Mono/Stereo” THatO|E{Qt Y X|5H=X| &OI5}HA]

[EDIT] > [Audio In] > [Mixing] > A/D In “Input Mode”

S 44X sy

m 0/0|3 S¥S &tols}
EER

P

= “Mic/Line” m2t0|E{ 7t M AT gfo 2 HHE[ g
AAE FXR|(o: 0ro[2)| £ ol W& W= o] 0|HE "Mic’2 HFFLCH s
Z8(0]0)2| £H £+F0| 2 W= 0| HFE “Line'22 HF
[UTILITY] > [Settings] - [Audio I/0] > “A/D Input”
m AID Y20 2% HHO| LR Lt
[EDIT] = [Audio In] = [Mixing] = A/D In “Volume”
m O|HE H¥o| HHEHYN}?

[EDIT] = [Audio In] = [Routing]

 AID Q&Ko £20| A MHEof UL

[UTILITY] > [Settings] > [Audio /0] > &2

w 30 O|HE T} MEE|0f QUEX| EOUSHIAI
HIAYE HA HEQ| AIME OHER MESH 22 mtat|ef 4

M5 Y0| o SFE MASHR| 8 4+ UBUCH

[EDIT] > WE MEd > 2 A/7|/Q 13| 0|E{ [Common] > [Effect] > [Routing]

B =

Fx|(ofl: Al Ato| x| 78t CD

4& 0] wat A/D INPUT [L/MONOJ/[R] 2Ol M & El @02
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£ 3

Yol FX|=|X| §f 1 X|&F L.

® [ARP ON/OFF] H{£0| 7{Zl ZS HE # =TI} HX|EE o HES LELCt

= Oo—

m & stHO| ZAIE o (W] (BX) HES =&ULCH
m 0|t Z2 O|HWE Z%0| X[LE|H O|HE MY S &QlotHU ThA| M{ZHAS MEHFL|CE
m D25t A7t AISEH OHS Ohato| e dE S EQlstH Al o] Ih2t0|H & “always”2 A SHH A A AEIQMHE 2HA| glo]
225t A7t 4 SE| B2 “always” 0[2|9| CHE HEI 2 st AR,
[UTILITY] = [Tempo Settings] > ‘El’ “Mode”
by )
A2t fSE L)
mO|HE HFo| HEFLM?
S7 40| o|HES A5 i TZo| WS 4 AgLch
[EDIT] > mtE MEH > @ A/7|/1{|0|E{ [Common] > [Effect]
m TE 20| HEUM?
TE 83 4H0| 42 £ OB o Zo| WAE & U&LICH
e Uuh HE(AWM2) W E3 ItEQ| B9
[EDIT] > otE MEf > @ A/7| MEH > [Filter]
o QU IHE (FM-X)2| B2
[EDIT] > mtE MEd > @ A/7|/Q 1| 0|E{ [Common] - [Pitch/Filter]
m (120 2F mWetole 27 & stet: &2 B™EIo of F2|Fo| st A&Unt?

[UTILITY] - [Settings] > [Sound] > £ |42 0|E{ “Volume’

[UTILITY] - [Settings] > [Audio /0] > “Output”

[EDIT] - [General] > “Volume”

[EDIT] > ntE MEd > 2 A/7|/2 12| 0|E] [Common] > [Part Settings] > [General] > “Volume”
* YU IIE(AWMD) Y £ THEQ| Z S

[EDIT] > mtE MEH > @ A/7| MEH > [Amplitude] - [Level/Pan] > “Level”
* Y THE(FM-X)Q| 42

[EDIT] > T}E MEd > Q2{|0|E{ MEH > [Level] > “Level”

| |
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B
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2 & X S0 MODXe| 2|Ch SAIY S+ (AWM2 1287 3 FM-X 647H)&

[=4
m O[3t &0 LRI Y ZEOM E=/E2] mat0|E7F "mono”2 EHE UE RAUULTH
AE AFXE HotH 0| Lp2tO|Ef & “poly” 2 HEHSHUAIR.

[EDIT] > ntE MEd 5> 2 A/7|/213|0|E] [Common] > [Part Settings] > [General] = “Mono/Poly”

mx| &= 7H40| 2 EUSH

® 2t T}EQ| OFAE] B Mbat0|E{7}'0" 0122 CHE 2O 2 MHE[0f UK LIN?
[UTILITY] - [Settings] - [Sound] > &£ H|L{2{|0]|E{ “Tune”

» 2 T}E Q| & 0|5 Wat0[E{7} 0" 01212 CHE 2O 2 MHE|of UL LING?

e UHMIIE (AWM2) X EZ IHEQ| F R
[EDIT] > THE MEH > 2 A/7|/Q H{|0|E{ [Common] > [Part Settings] > [Pitch] > “Note Shift’
[EDIT] > ntE MEd 5> 2 A/7|/Q | 0|E{ [Common] > [Part Settings] > [Pitch] > “Detune”

* Y THE(FM-X)2| 42
[EDIT] > THE MEH > 2 A/7|/Q H#|0|E{ [Common] > [Pitch/Filter] > [Pitch] > “Note Shift”

[EDIT] > mtE MEH > 2 A/7|/@ 1 2||0|E| [Common] - [Pitch/Filter] > [Pitch] - “Detune”
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m HEOA ZRE X7 Hd=l= 2 00|22 §'d mEt0[E0|M HEet T3 A|AR 0] MEHE|O] U&ELI?
* Ut TFE(AWMR)9] H 2
[EDIT] > mtE MEH > 9 A/7|/@12||0]E] [Common] - [Part Settings] - [Pitch] > “Micro Tuning Name”
* Y THE(FM-X)Q| 42
[EDIT] > ntE MEd 5> 2 A/7]|/2 13| 0|E] [Common] > [Pitch/Filter] - [Pitch] = “Micro Tuning Name”
m DHEO|A RRE X7 MHEIE AL LFO M| # X 20|17t 42 &2 4HEI0] A& LN
o YUt THE(AWM2)2] B2
[EDIT] > TE MEf > 2 A M
* Y THE(FM-X)Q| 42
[EDIT] > TtE MEY 5> 2 A/7|/HZ|0|E| [Common] = [Mod/Control] > [2nd LFO] = “Pitch Modulation”
m ItEOM 2R2E LX|7t HYEl= d UM T H 0IM &8 20| AU
* Ut OFE(AWM2) % £ THEQ| B
[EDIT] > otE MEf > @ A/7| MEH > [Osc/Tune] > “Coarse”
[EDIT] > TE MEH 5> @ A/7| MEH 5 [Osc/Tune] > “Fine”
o Yt THE(FM-X)0] 2 ¢
[EDIT] > utE MEd > @ 12||0|E{ MEH > [Form/Freq] = “Coarse”

[EDIT] > mE MEd > Q13| 0|E{ MEH > [Form/Freq] > “Fine”

" TEOA RRE LE|7HYHEE HHY 2ols 3L HESE ThAo| ‘Pich'2 HHEOf Y&

[EDIT] > mtE MEH > [Mod/Control] - [Control Assign] = “Destination”

o|= 7} & 8E|X| gf&Uct.
m O|HE AQX|7} A UEYNI?

[UTILITY] > [Effect Switch]

RER

of
R
rr

2|l H&0] ‘0" 099 T} Zto 2 MFE|H Y&LN?
[EDIT] > mtE MEH > 9 A/7|/@ 13| 0|E| [Common] > [Effect] > [Routing] > “Var Send”
[EDIT] > mtE MEH > 2 A/7|/1{|0|E] [Common] - [Effect] > [Routing] > “Rev Send”

m B |E E= 2| e 2|H0] “0” 0|2|Q| THE e 2 HEE|o JUFUIN?
[EDIT] - [Effect] - [Routing] > “Var Return”
[EDIT] - [Effect] = [Routing] = “Rev Return”

" 24/7]0 QME O|ME £ matn|E| & st £ D5 0|HE Mo A thu'E HHE A&

[EDIT] > ntE MEd 5> 2 A/7|/21{3|0|E| [Common] > [Effect] > [Routing] > “Element 1-8”

...

" AlA% O|HEO| H O|HE EtY B SHLt

Ooc

i
" QIME O|HEQ| YL O|HE EfY B Sit EE B Thu'2 MHE|AEUIN?
w QLM E AQIX| mat0|E{7t SHEEA HHEOf Ut

[EDIT] > mtE MEH > 2 A/7|/@ 12| 0|E{ [Common] - [Effect] = [Ins Al/[Ins B]

" QIME O|HEV MY IHE 48 WAL

THE 9-160] B9 QIME O[HES HIth 47} THENK| HEE 4 UsUCH

[EDIT] > ntE MEd 5> 2 A/7|/21{3|0|E{ [Common] > [Effect] = [Ins Assign]

OIEH|X|RE Al=tE & flguU L.
m [ARP ON/OFF] HHEO0| AN U =X|, HH =

m O ZH|X|Q AQIRI7} 7%l THEQ| £8 AL

%|CH 871 0| THEMIX| OFZH|K| QS S Alof| K A4EH 4 Y& LICh

" S BHE U A7| BHEQt 22 OfZH|K|Q B matn|e 7t MEs| MHEof UL

[EDIT] > ntE MEd 5> 2 A/7|/Q 1| 0|E{ [Common] = [Arpeggio] = [Common]

B =
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£ 3

m OL2H|X|Q & 4! mpatn|E{7} off 2 M E of UELTI}?
[EDIT] > mtE MEH > [Arpeggio] > [Individual] > “Name”

® O 2H|X|Q A9|X| TtatO|E{ S &QIFHLICE
X mEQ| o| m2to|E{7t "off' 2 HFE A< [ARP ON/OFF] H{E0| 74X U0 E et HEZHAE S5 Ot 2HX| 2 THAH 0|
Ea2|7g|x| Q&LCH

[PERFORMANCE (HOME)] > T}E MEd > ‘Arp On”
m [Arp Bypass] H{E0| “on”"Q 2 MHE|0] Q&LII?
[UTILITY] - [Effect Switch]

OtE2H|X| & FX[& + g&EUCt
w 7|0l A &2 mE Ot2HX| @ KA40| HXISHK| ofe A2 otZHX|Q BE matn|H g ‘off 2

[EDIT] > ntE MEd 5> 2 A/7]|/212|0|E] [Common] > [Arpeggio] > [Common] > “Hold”

St AR,

OII

[>] (R HES 53 40| A[ZE|X| ¥&LICH

m MEHZE S0 dH| = Hlo[B7F ZEte|of AELI?

#0| 5L/ g&UL
m =30 EQ3t o HR2EIt F23| UA&EUI?
MODX M| 22| = 2T 128712 §& =3& + UAFULH W27} 715 XA O o[ 4o 532 S7tsEuUTt

FE{} MODX 7t Cl|o|E] §410]| MICH 2 E[X| &Lt
n 5"‘“E-| TE MAE0| MESHK| 801544 L.
= MIDI IN/OUT Tato| {7 &5k gto 2 MHE|0f UK 0fHE SHQI5HIAIQ.
[UTILITY] = [Settings] - [MIDI /0] > MIDI “MIDI IN/OUT”

A A
MIDI ' 3 Co|E] &4l/4-410] HICH 2 %S 6tX| &L T}
m HI SOOI AR 2 HFE[o AESHIL?
W3 440 Thato|EE AR o2 MR
[UTILITY] > [Settings] - [Advanced] - MIDI “Receive Bulk”
€3 @I 7|52 AFBSH0] H4E T 9|8 MIDI FR(0] SSEE MIDI €3 o[BS 44150 A2 MIDI EA| ©5E Hs
Aot Ze gro 2 Misiof huct.
[UTILITY] = [Settings] = [Advanced] = MIDI “Device Number”
N E MEEX| otz 22 MODXo|| AZAE MIDI 7|7|2| #X| HME7t X S met0|E et UR|IEE HHEI AESUMN?
[UTILITY] - [Settings] - [Advanced] > MIDI “Device Number”

USB Z2llA| E2t0|Eof| CIo|E & X && + st
m USB E2iA| E2}0|E0f| 47| &X] 7| 50| AFEE| I UELI? (HIO|HE MEsta{ T 7| XS HH|aHof &L C)
m USB Z2liA| E2t0|E9| 0|8 753 S0 S2& U
L& St M A EX|E USB S2liA| E2to|EE AFEUCH 5tH QEXE AT ZA|Z USB Z2{A| E210|E 9| JHXH AtE
7tseHOjArE) Hi2E|e| 27| & gelgurt.
[UTILITY] - [Contents] > [Load]/[Store/Save]

m Yamaha’} S% USB Z2{A| E2to| 50| %52 HEFLII?
KtM|8H LHE 2 61| 0]|X| & £ XSHAA|2.
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MODX8: 8874, GHS 74tk x7| E1'
MODX7: 7674, M|O| l[0|E|E 744t
MODX6: 6171, M|O| Yl0|E|E 74t

=3
=

EnMole] = MU0y

D6 HEES By AT

AWM2: 8712| @ A
FM-X: 8712 Q{a||0|E{, 8872] %D a|=

i

AWM2: 128(Z|Cf, AHH /2 & T+)
FM-X: 64(Z|CH)

1671 THE(LHE), 2C]Q 9= mkE(AD'T, USB™)
1 AHYR THE

fri=1) Z2|MIE: 567 GB(16H|E 2|L|of HA 02 #3t A|), AHEX}: 1.00 GB
HEHA ok 2 00074
== 187HK| A
O|HE AlAH 2le =127 HAY), (8571 & A)), QIME(A, B) (857H #Al)2, OtAE 0| E(237H HAl)
*2 AID IHE QI M E(807H #Al)
<z} o|Hl E EtQlo| matn|E{of st Z2|HEE MESO 2 XI>
OFAE EQ(571 YHE), 1x} THE EQ(37] YHE), 2X} THE EQ(27H 4HE)
ANHMEE g8 ok 130,00071 &
2E gills 480 ppa(4E S EY ME )
&l 2 (BPM) 5-300
HEMHA & 12871
=27I
Eaf 1670 A|HA E2H Bz E2H Scene EZ
=8 4 HAIZHEER 7|, HAIZE AR, A AIZHHER| Q1/0rR
KA 344l MODX 224 &4!, SMF &4 0, 1
OF2H|X|Q o E SA| 870 mE(2|TH)
ZEME 10,2397tX| &4l
User 2567tX| A
DM AEM R 8 + 17 2ll(2IcH)
7|E} 2tolE NE Z2|M|E: 2567H 0|4, AFEXt: 2,048
HEEP F 2 ADYH IOl L2, USB 3, Elil #ic g msoldE,
HEE &2to|r{(47l), =E(47M), +T =&, H|o|Ef C}o|H
5o 7" TFT 22 9t0|= VGA LCD E{%| A3
FUIE [USB TO DEVICE], [USB TO HOST], MIDI [IN}/[OUT], FOOT CONTROLLER [1]/[2],
FOOT SWITCH [ASSIGNABLE]/[SUSTAIN], OUTPUT [L/MONOQJ/[R] (6.3mm, & & ),
[PHONES] (6.3mm, BEZ& AHYQ &= ™),
A/D INPUT [L/MONOJ/[R] (6.3mm, B & &= )
UsBer|le  MEY o4 441kHz
QIE{H 0| A
NI U4 iH ( AHER ')
Z2H. 1022 (5 AHHL M)
Al M 16W(PA-150B AC O{HE{ AL A])
NESET1 MODX8: 1,333 (W) x 404 (D) x 160 (H) mm, 13.8 kg
MODX7: 1,144 (W) x 331 (D) x 134 (H) mm, 7.4 kg
MODX6: 937 (W) x 331 (D) x 134 (H) mm, 6.6 kg
H4E AC O{HE{(PA-150B = 0|0f| &5H= ofntst HE KIE*), AHSHBEAM(E 2X}), Cubase AILHRZE HE
* Kol mat Z3E|X| §F2 A& Y&ULCH Yamaha YR 0f| 225t AIQ.

: 22 IX Q2{® Yamaha A0 Eo| 4 5 sl My UL Cte2 e
ME S52 XG0l et HPE > A28 =2, Y X|H92| Yamaha UM 2 t

MODX Ab24H A




GNU GENERAL PUBLIC LICENSE
GNU LESSER GENERAL PUBLIC LICENSE

AA AC HZOf B FOlAFE
5|5 &1 % 3G7HA S GNU U8t 38 2Lo|4lA S GNU o4
02 Yamahaoll T+ 542 283 4 Y& LCH

DMI Marketing Group, DMI Division

Musical Instruments Business Division

YAMAHA Corporation

10-1 Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, JAPAN
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E=EREENSEUL B & EE ArEXtof|7| MEst=H
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A

A/D INPUT [GAIN] S EH 10
A/D INPUT [L/MONOY/[R] ZH ..o 17
A/D INPUT [ON/OFF] BHE ... 10
ABS(AUdIO BEAt SYNC) ..ooiiiiiiiiiiii e 17
[ARP ON/OFF](O}2H|X| 2 on/off) HE ... 11
[ASSIGN 1] & [ASSIGN 2] HE(X| ™ 75 AR 1H 2)....... 10
[ASSIGN] H{E o 12
[AUDITION] BHE L. 15
C

[CATEGORY ] H{E 15
[CONTROL ASSIGNIHHE ... 13
D

DAW(L]X|E QO] IAHIO|M) e 55
[DC INT e 17
[DEC/NOT B E . 14
E

[EDITIHE. ...

[ENTER] HE

[EXIT B

F

VL 38
FOOT CONTROLLER [11/[2] ZH .o 17
FOOT SWITCH [ASSIGNABLE]/[SUSTAIN] 24 ... 17
G

GV 22
GM B 3 22
|

[INC/YEST B{E .. 14
K

KNOB POSITION [1] & [2]
Knobs 1-4(5-8)

L

[LIVE SET] BB oot 15
M

[MASTER VOLUME] s oo 10
MIDI TIN, [OUT]T EERF oot 17
Y T I = TS 45
MIDE 2 AL RS oo 54
YT L S 54
XTI S 56
Y T == RS 56
[MOTION SEQ HOLD](2 A A|HA EC)HE ... 11
[MOTION SEQ TRIGGER](24 A|HA E2|H) HE .. 11
[MS ON/OFF](Z A1 Al A On/off) BHE .ooovooveeeeoeeeee e, 11

o

OCTAVE [[] H [+] HHE . 11
OUTPUT [L/MONO] 2 [R] H .. 17
P

[PART SELECT MUTE/SOLOIHE ... 15
[PERFORMANCE (HOME)] FHE ... 14
Performance Play SFH ... 20
[PHONES] (Sl E &) B e 17
R

[RHYTHM PATTERN] BHE ... 13
S

SCENE [1/5] [2/6] [3/7][4/8] HHE ..o 12
SCBNE 7 S o 34
Scene MEH [1-4] [6-8]HHE ... 12
SEQ TRANSPORT BHE ... 13
[SHIFT] Bl e, 14
SSS(Seamless Sound SWiItChing) .......ooovviiiiiiiic 23

[STORE] HE

U
[USB TO DEVICE] K oo 17, 61
[USB TO HOST] =K} oo 17,56
[USB VOLUME (MONITOR)] L H .o 10
[UTILITY B e 14
Y
Yamaha Steinberg USB E2F0[H .........ooooiiiiiiiiiecece 55
=1
A 10
ZAHEO A B 21
L

|

CFE TFE EEHA e, 22
EFQUTFE I EEHA e, 22
[PIEHZ1/FAT) AQIR| oo 17
HHOTE] TFOI D oo 14
BB IFE oo 22
=2

BEOIEL MIE. oo 23,35
BHOIEL MIE BFEH oo 20
BROIE B ) BHI oo 22
R O1 O et
2HEES

2|5 WE .

BIE THEL et
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a

OFAE] B 52
OFOI 3 o 50
a0 & 10
SO, 38
A AIA 28
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| NORTH AMERICA |

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Toronto, Ontario M1S 3R1,
Canada
Tel: +1-416-298-1311
U.S.A.
Yamaha Corporation of America
6600 Orangethorpe Avenue, Buena Park, CA 90620,
US.A.
Tel: +1-714-522-9011

[ CENTRAL & SOUTH AMERICA _|

MEXICO
Yamaha de México, S.A. de C.V.
Av. Insurgentes Sur 1647 Piso 9, Col. San José
Insurgentes, Delegacion Benito Juarez, México,
D.F.,, C.P. 03900, México
Tel: +52-55-5804-0600
BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Fidéncio Ramos, 302 — Cj 52 e 54 — Torre B —
Vila Olimpia — CEP 04551-010 — Sao Paulo/SP,
Brazil
Tel: +55-11-3704-1377
ARGENTINA
Yamaha Music Latin America, S.A.,
Sucursal Argentina
Olga Cossettini 1553, Piso 4 Norte,
Madero Este-C1107CEK,
Buenos Aires, Argentina
Tel: +54-11-4119-7000
PANAMA AND OTHER LATIN
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES
Yamaha Music Latin America, S.A.
Edif. Torre Banco General, F7, Urb. Marbella,
Calle 47 y Aquilino de la Guardia, Panama,
P.0.Box 0823-05863, Panama, Rep.de Panama
Tel: +507-269-5311

| EUROPE |

THE UNITED KINGDOM/IRELAND
Yamaha Music Europe GmbH (UK)
Sherbourne Drive, Tilbrook, Milton Keynes,
MK?7 8BL, UK.

Tel: +44-1908-366700

GERMANY
Yamaha Music Europe GmbH
Siemensstrasse 22-34, 25462 Rellingen, Germany
Tel: +49-4101-303-0

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Europe GmbH, Branch
Switzerland in Thalwil
Seestrasse 18a, 8800 Thalwil, Switzerland
Tel: +41-44-3878080

AUSTRIA/CROATIA/CZECH REPUBLIC/

HUNGARY/ROMANIA/SLOVAKIA/

SLOVENIA
Yamaha Music Europe GmbH, Branch Austria
Schleiergasse 20, 1100 Wien, Austria
Tel: +43-1-60203900

POLAND
Yamaha Music Europe GmbH
Sp.z o0.0. Oddzial w Polsce
ul. Wielicka 52, 02-657 Warszawa, Poland
Tel: +48-22-880-08-88

BULGARIA
Dinacord Bulgaria LTD.

Bul.Iskarsko Schose 7 Targowski Zentar Ewropa
1528 Sofia, Bulgaria
Tel: +359-2-978-20-25

MALTA
Olimpus Music Ltd.

Valletta Road, Mosta MST9010, Malta
Tel: +356-2133-2093

NETHERLANDS/BELGIUM/

LUXEMBOURG
Yamaha Music Europe, Branch Benelux
Clarissenhof 5b, 4133 AB Vianen, The Netherlands
Tel: +31-347-358040

FRANCE
Yamaha Music Europe
7 rue Ambroise Croizat, Zone d'activités de Pariest,
77183 Croissy-Beaubourg, France
Tel: +33-1-6461-4000

ITALY
Yamaha Music Europe GmbH, Branch Italy
Via Tinelli N.67/69 20855 Gerno di Lesmo (MB),
Italy

Tel: +39-039-9065-1

SPAIN/PORTUGAL
Yamaha Music Europe GmbH Ibérica, Sucursal
en Espaia
Ctra. de la Corufia km. 17,200, 28231
Las Rozas de Madrid, Spain
Tel: +34-91-639-88-88

GREECE
Philippos Nakas S.A. The Music House
19th kIm. Leof. Lavriou 190 02 Peania — Attiki,
Greece
Tel: +30-210-6686260

SWEDEN
Yamaha Music Europe GmbH Germany filial
Scandinavia
JA Wettergrensgata 1, 400 43 Goteborg, Sweden
Tel: +46-31-89-34-00
DENMARK
Yamaha Music Denmark,
Fillial of Yamaha Music Europe GmbH, Tyskland
Generatorvej 8C, ST. TH., 2860 Seborg, Denmark
Tel: +45-44-92-49-00
FINLAND
F-Musiikki Oy
Antaksentie 4
FI-01510 Vantaa, Finland
Tel: +358 (0)96185111
NORWAY
Yamaha Music Europe GmbH Germany -
Norwegian Branch
Grini Neringspark 1, 1332 @steras, Norway
Tel: +47-6716-7800
ICELAND
Hljodfaerahusid Ehf.
Sidumula 20
IS-108 Reykjavik, Iceland
Tel: +354-525-5050
CYPRUS
Nakas Music Cyprus Ltd.
Nikis Ave 2k
1086 Nicosia
Tel: +357-22-511080
Major Music Center
21 Ali Riza Ave. Ortakoy
P.0.Box 475 Letkosa, Cyprus
Tel: (392) 227 9213
RUSSIA
Yamaha Music (Russia) LLC.
Room 37, entrance 7, bld. 7, Kievskaya street,
Moscow, 121059, Russia
Tel: +7-495-626-5005
OTHER EUROPEAN COUNTRIES
Yamaha Music Europe GmbH
Siemensstrasse 22-34, 25462 Rellingen, Germany
Tel: +49-4101-303-0

| AFRICA |

Yamaha Music Gulf FZE

JAFZA-16, Office 512, P.O.Box 17328,
Jebel Ali FZE, Dubai, UAE

Tel: +971-4-801-1500

| MIDDLE EAST |

TURKEY
Yamaha Music Europe GmbH
Merkezi Almanya Tiirkiye Istanbul Subesi
Maslak Meydan Sodak, Spring Giz Plaza Bagimsiz
Bol. No:3, Sariyer Istanbul, Turkey
Tel: +90-212-999-8010
ISRAEL
RBX International Co., Ltd.
P.O Box 10245, Petach-Tikva, 49002
Tel: (972) 3-925-6900

OTHER COUNTRIES
Yamaha Music Gulf FZE
JAFZA-16, Office 512, P.O.Box 17328,
Jebel Ali FZE, Dubai, UAE
Tel: +971-4-801-1500

I ASIA

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co., Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu,
Shanghai, China
Tel: +86-400-051-7700

HONG KONG
Tom Lee Music Co., Ltd.
11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: +852-2737-7688
INDIA
Yamaha Music India Private Limited
P-401, JIMD Megapolis, Sector-48, Sohna Road,
Gurgaon-122018, Haryana, India
Tel: +91-124-485-3300

INDONESIA
PT. Yamaha Musik Indonesia (Distributor)
Yamaha Music Center Bldg. Jalan Jend. Gatot
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: +62-21-520-2577

KOREA
Yamaha Music Korea Ltd.
11F, Prudential Tower, 298, Gangnam-daero,
Gangnam-gu, Seoul, 06253, Korea
Tel: +82-2-3467-3300

MALAYSIA
Yamaha Music (Malaysia) Sdn. Bhd.
No.8, Jalan Perbandaran, Kelana Jaya, 47301
Petaling Jaya, Selangor, Malaysia
Tel: +60-3-78030900

SINGAPORE
Yamaha Music (Asia) Private Limited
Block 202 Hougang Street 21, #02-00,
Singapore 530202, Singapore
Tel: +65-6740-9200

TAIWAN
Yamaha Music & Electronics Taiwan Co., Ltd.
2F., No.1, Yuandong Rd., Banqiao Dist.,
New Taipei City 22063, Taiwan (R.O0.C.)
Tel: +886-2-7741-8888

THAILAND
Siam Music Yamaha Co., Ltd.
3,4, 15, 16th F1., Siam Motors Building,
891/1 Rama 1 Road, Wangmai,
Pathumwan, Bangkok 10330, Thailand
Tel: +66-2215-2622

VIETNAM
Yamaha Music Vietnam Company Limited
15th Floor, Nam A Bank Tower, 201-203 Cach
Mang Thang Tam St., Ward 4, Dist.3,
Ho Chi Minh City, Vietnam
Tel: +84-28-3818-1122

OTHER ASIAN COUNTRIES
https://asia-latinamerica-mea.yamaha.com/
index.html

I OCEANIA

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 80 Market Street, South Melbourne,
VIC 3205 Australia
Tel: +61-3-9693-5111
NEW ZEALAND
Music Works LTD
P.0.BOX 6246 Wellesley, Auckland 4680,
New Zealand
Tel: +64-9-634-0099
COUNTRIES AND TRUST
TERRITORIES IN PACIFIC OCEAN
https://asia-latinamerica-mea.yamaha.com/
index.html

DMI24

Head Office/Manufacturer: Yamaha Corporation 10-1, Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, Japan

(For European Countries) Importer: Yamaha Music Europe GmbH Siemensstrasse 22-34, 25462 Rellingen, Germany
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